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Welcome to REAKTOR

1 Welcome to REAKTOR

REAKTOR is a visual programming environment based on modules and wires, allowing you to
create any musical tool imaginable. Its many uses include music creation, digital art, instru-
ment and effects building, as well as scientific applications. REAKTOR 6 builds on a long his-
tory of legendary software including NI's first product, GENERATOR.

5. REAKTOR L Welcome to REAKTOR 6
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Welcome to REAKTOR 6

Known for its unrivalled sound quality, REAKTOR is the complete toolkit for creating instru-
ments and effects with high-quality DSP components. The included content allows you to look
behind the curtain and explore the state-of-the-art technology at the core of many of our prod-
ucts. REAKTOR Racks facilitate analog-style modular patching with Blocks—the perfect intro-
duction to using modules and wires to create your own instruments.
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System Requirements

From playing and combining pre-built instruments and effects to building your own tools with
its extensive Library or creating custom DSP algorithms, REAKTOR suits musicians, builders,
and programmers alike. Based on a hierarchical structure with a coherent interface, REAKTOR
is optimized to facilitate all of these use cases. This means that you can approach REAKTOR
level by level, making yourself familiar with its deep functionality one step at a time.

The REAKTOR 6 documentation adapts this approach, guiding you through the different levels
of functionality in a clear and comprehensible manner. The Getting Started and Diving Deeper
documents cover all basic functions and settings in REAKTOR, while the tutorials and instruc-
tions provided in Building in Primary and Building in Core make creating your own musical tools
more accessible than ever before.

REAKTOR is fortunate to be supported by a large community of experienced users who actively
share their Ensembles in the REAKTOR User Library on our website. There are thousands of
REAKTOR Ensembles available, ready to be played, combined and modified—a great source of
inspiration, both musically and technologically. We invite you to join this vibrant community
and are looking forward to seeing and hearing your new creations!

1.1 System Requirements

Your computer system needs to meet certain requirements in order to run REAKTOR.
For the latest REAKTOR system requirements and compatibility information visit:

www.native-instruments.com/reaktor6specifications

1.2  REAKTOR Modes: Full, Player and Demo

What you can do with the REAKTOR version installed on your computer depends on which
mode REAKTOR is running in. This mode depends on the license you are using:

e Full mode: If you have already installed and activated REAKTOR, as a single product or as
part of a bundle like KOMPLETE, you are using it in Full mode. In Full mode, all func-
tionality is available without restrictions.

REAKTOR 6 - Getting Started - 7
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Welcome to REAKTOR
The REAKTOR 6 Documentation

¢ Player mode: You have installed and activated any of the KOMPLETE instruments and ef-
fects for REAKTOR and the free REAKTOR Player. In Player mode you can play Instru-
ments and change their settings, but cannot edit their internal structure. Play mode also
allows you to patch and play with Blocks in Racks. All Instrument settings are saved with
your host project when using REAKTOR as a plug-in.

e Demo mode: You installed REAKTOR and a number of KOMPLETE Instruments as demo
versions, but did not activate any of the products yet. In this case you are using the demo
license for REAKTOR, and REAKTOR is running in Demo mode. In Demo mode, you have
all functionality but the application will stop generating sound after 30 minutes. Further-
more, storing is disabled.

1.3  The REAKTOR 6 Documentation

File Edit Settings Options View Helpl}

©. REAKTOR Launch Service Center 130.0
Open What's Mew
Lilsmzs Open Getting Started
Open Diving Deeper
Open Building in Primary

Open Building in Core

Yisit Reaktor on the Web
Visit the Knowledge Base

Visit the UserLibrary on the Web

About Reaktor 6

The REAKTOR documentation is accessible from the Help menu

The documentation for REAKTOR 6 is divided into five separate documents, guiding you from
loading and playing pre-built Ensembles to building your own Instruments.

e REAKTOR 6 What Is New is written for users who are already familiar with previous versions
of REAKTOR and only describes the latest features in brief.

REAKTOR 6 - Getting Started - 8



Welcome to REAKTOR
REAKTOR Content Documentation

e REAKTOR 6 Getting Started is for new users. It is the only document needed for users who
intend to use REAKTOR for loading and playing pre-built REAKTOR instruments and ef-
fects.

e REAKTOR Blocks Quick Start Guide is an online resource showing you how to use REAKTOR
Blocks in the Rack format. Find it here: www.native-instruments.com/reaktor-blocks-
quickstart

e REAKTOR 6 Diving Deeper expands on the concepts introduced in the Getting Started docu-
ment. It provides more detail on subjects like Snapshots (REAKTOR's preset system), and
introduces advanced topics like OSC control and combining multiple Instruments in one
Ensemble.

e REAKTOR 6 Building in Primary shows you how to build your own Instruments in REAK-
TOR’s Primary level. It focuses on a series of tutorials that guide you through building
your first synthesizers, effects, and sequencers.

e REAKTOR 6 Building in Core describes the Core level of REAKTOR with its low-level build-
ing features, which can be used for implementing custom DSP algorithms. It includes ref-
erence information about the Core Macro Library, an comprehensive collection of DSP
building blocks.

With the exception of the What Is New document, each of the documents listed above builds
on the knowledge of the previous documents. While it is not necessary to read all of every
document, some of the more advanced documents, like Building in Primary, assume knowl-
edge from the previous documents.

In-depth information about using REAKTOR Blocks in Ensembles can be found in the
REAKTOR Blocks Manual. To learn about opening manuals for REAKTOR content, refer
to 11.4, REAKTOR Content Documentation.

1.4  REAKTOR Content Documentation

REAKTOR comes with a comprehensive Factory Library, including many pre-built instruments
and effects, as well as Blocks, a new modular synthesizer framework that brings the experience
of patching an analog modular synthesizer to REAKTOR. The manuals for this content, as well
as any REAKTOR-based KOMPLETE instruments or effects you have installed, can be ac-
cessed from the Browser in REAKTOR'’s Side Pane.

REAKTOR 6 - Getting Started - 9
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Welcome to REAKTOR
REAKTOR Content Documentation

To open the manuals for REAKTOR content:
1. Click on the Browser icon in the Side Pane to open the Browser.

©. REAKTOR o
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Welcome to REAKTOR
REAKTOR Content Documentation

3. Double-click on the folder of the content you wish to view the manual for.

©. REAKTOR p Untitled Snapshot
o

Player Library

4. Select the Documentation subfolder. The manual shows up as a PDF file in the lower sec-
tion of the Browser.

©O. REAKTOR p Untitled Snapshot
o

Player Library

| I REAKTOR Elocks Manual English...

5. Double-click on the PDF file.
= The manual will open in your standard PDF reader.
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Manual Conventions

1.5  Manual Conventions

This section introduces you to the signage and text highlighting used in this manual.

e Text appearing in (drop-down) menus (such as Open..., Save as... etc.) and paths to loca-
tions on your hard disk or other storage devices is printed in italics.

e Text appearing elsewhere (labels of buttons, controls, text next to checkboxes etc.) is
printed in blue. Whenever you see this formatting applied, you will find the same text ap-
pearing somewhere on the screen.

e |mportant names and concepts are printed in hold.

e References to keys on your computer’s keyboard you’ll find put in square brackets (e.g.,
“Press [Shift] + [Enter]”).

1. Single instructions are introduced by this play button type arrow.
= Results of actions are introduced by this smaller arrow.

An indented, gray paragraph contains additional, contextual information.

Furthermore, this manual uses particular formatting to point out special facts and to warn you
of potential issues. The icons introducing these notes let you see what kind of information is to
be expected:

@ The speech bubble icon indicates a useful tip that may often help you to solve a task
more efficiently.

The exclamation mark icon highlights important information that is essential for the giv-
en context.

The red cross icon warns you of serious issues and potential risks that require your full
attention.

REAKTOR 6 - Getting Started - 12



Getting to Know REAKTOR

The Interface at a Glance

2 Getting to Know REAKTOR

REAKTOR can be used in many different ways, from loading and playing pre-built Ensembles,
to building new Instruments using the Modules and Macros Library, to programming your own
DSP building blocks in Core. REAKTOR's interface and file hierarchy are optimized to facilitate
all these use cases, offering clear workflows for the task at hand. This section gives an over-
view over the interface, the Play Mode and the Edit Mode, as well as the file types used in RE-
AKTOR.

2.1  The Interface at a Glance

REAKTOR's interface can be divided into three main areas:

The REAKTOR Interface

REAKTOR 6 - Getting Started - 13



Getting to Know REAKTOR

(1) Toolbar: The area along the top is called the Toolbar and contains a lot of REAKTOR's glob-
al options and settings (see section 12.2, The Toolbar).

(2) Main area: The main area in the center displays either the loaded Instrument Panel, the
Structure of the Ensemble, or both (the area can be split with the options in the upper-right
corner).

(3) Side Pane: The area to the left is called the Side Pane and contains a number of different
functions categorized by tabs:

e Browser (see section The Browser)

e Snapshots (see section 16.3, Snapshots and Presets)

e Connection Manager (see section 19.2, Connection Manager)

e Panelsets (find more information in the Diving Deeper document)

e Properties (find more information in the Diving Deeper document)

2.2  The Toolbar

The toolbar, located along the top of REAKTOR's interface, gives you access to many of the
main options and parameters in REAKTOR.

.. REAKTOR fel Untitled Snapshot 120.0 o =

The toolbar in REAKTOR

(1) REAKTOR icon: Clicking on the REAKTOR icon opens a window displaying information about
the software. This window can be used to find the version number of your current REAKTOR
installation, which is located to the top left of the window.

The Toolbar
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Getting to Know REAKTOR

(2) Open main menu: The arrow to the right of the REAKTOR icon opens the main menu. This
contains many different options and functions which are referenced throughout the documen-
tation.

(3) Show Side Pane: The magnifying glass button shows or hides the Side Pane. The Side Pane
hosts a variety of functions and settings, organized in tabs. See sections The Browser, 16.3,
Snapshots and Presets, and 19.2, Connection Manager for more information. The Panelsets
and Properties tabs are described in the Diving Deeper document.

(4) Toggle Edit Mode: The EDIT button toggles Edit Mode on or off. See section 12.3, Play
Mode vs Edit Mode for more information.

(5) Snapshot menu: The Snapshot menu is where you can browse and load Snapshots from the
loaded Ensemble. Snapshots are REAKTOR's main sound preset type and are explored in more
detail in section 16.3, Snapshots and Presets. Clicking on the Snapshot name opens the snap-
shot menu. The up and down arrows to the right of the menu can be used to cycle through the
sSnapshots.

(6) Transport: The transport controls are used to control the global playback. See section
12.2.1, Transport for more information.

(7) Show Sample Map Editor: The button with the waveform icon shows or hides the Sample
Map Editor. This button is only available if the loaded Ensemble contains a Sampler Module.
The Sample Map Editor is described in the Diving Deeper document.

(8) Show Player and Recorder: The button with the tape reel icon shows or hides the Player and
Recorder. The Player and Recorder utilities allow you to play back and record audio files. The
Player and Recorder are described in the Diving Deeper document.

(9) Show Info Hints: This button shows or hides the tool tip information when placing the mouse
over an element in the user interface. See section 12.2.2, Info Hints for more information.

(10) Audio input level meter: The audio input level meter lets you monitor and adjust the input
level for signals arriving at REAKTOR’s inputs. The audio input meter is only visible if the load-
ed Ensemble includes audio inputs. See section 12.2.3, Audio Input & Output Level Meters for
more information.

The Toolbar
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Getting to Know REAKTOR

(11) MIDI/OSC input and output: The MIDI/OSC input and output indicators light up when REAK-
TOR sends or receives any MIDI and OSC messages. MIDI and OSC are the main ways of con-
trolling REAKTOR with hardware. The indicators are useful for checking if your hardware is
communicating with REAKTOR. See section 19, Controlling REAKTOR for more information
about MIDI and OSC.

(12) Audio output level meter: The audio output level meter lets you monitor and adjust the out-
put level for signals sent from REAKTOR’s outputs. See section 12.2.3, Audio Input & Output
Level Meters for more information.

(13) System info: The system info area contains displays and controls for the system and audio
status. See section 12.2.4, System Info for more information.

(14) Nl icon: Clicking on the NI icon opens a window displaying information about the software.
This window can be used to find the version number of your current REAKTOR installation,
which is located to the top left of the window.

2.2.1  Transport

Znagd Pulschor 120.0

The Transport controls in REAKTOR

Since REAKTOR can be used to create sequencers, REAKTOR has its own transport for con-
trolling playback.

The transport controls are not available in the plug-in version of REAKTOR since it uses
the host’s transport settings.

The Toolbar
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Getting to Know REAKTOR
The Toolbar

e The leftmost button resets the play position (meaning it rewinds the play head to position
zero). You can also reset the play position by pressing [ctrl] + [space] (Windows) or [cmd]
+ [space] (OS X) on your computer keyboard.

e The center button is the play button. It is used to start or pause playback. You can also
start or pause playback by pressing [space] on your computer keyboard.

e The value display to the right is where you can define the playback tempo in BPM (beats
per minute). You can do this either by clicking and dragging the value up and down, or by
double-clicking and typing in a new tempo.

2.2.2 Info Hints

Many of the elements in REAKTOR's user interface show tool tip information when you place
the mouse over them. This information is called an Info Hint in REAKTOR. The Info Hints can
be enabled from the toolbar.

1. Click on the Show Info Hints button in the toolbar to enable the Info Hints. Alternatively,
press the keyboard shortcut [ctrl] + [i] (Windows) or [cmd] + [i] (OS X).

o HIDI
ul=ed
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Getting to Know REAKTOR

= The Info Hints are now shown as soon as you place the mouse over an element in REAK-
TOR’S user interface.

©. REAKTOR o

SEWEN Browse Komplete Instruments and Effects el

@ A Ens - Rounds E 001 Block Buster®

ROUNDS

B Kontour

2.2.3  Audio Input & Output Level Meters

120.0 HiDI

REAKTOR LIERARY

The audio input and output level meters in REAKTOR

The audio input and output level meters let you monitor and adjust the level of audio signals
arriving at REAKTOR’s audio inputs as well as audio signals sent from REAKTOR’s audio out-
puts.

@ The audio input level meter is only visible if the loaded Ensemble includes audio inputs.

If the signal level is too high and the input or output is overloading, red lights will appear at
the right edge of the meters.

The Toolbar
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Getting to Know REAKTOR

Below each of the meters is an arrow. Clicking and dragging on the arrow sets the input or out-
put signal level. For example, if the output of an instrument is too loud, you can lower the sig-
nal level by moving the arrow below the output meter to the left.

2.24  System Info

o Hio
osc

VEL:100 TUNE: D DEC:100 VOL: -1dB

The system info in REAKTOR

The rightmost area in the toolbar contains the system info and controls.
e The top left desplay shows a measure of the CPU load in percent.

e The bottom left display shows the currently set sample rate. Clicking on it opens a drop-
down menu for selecting the sample rate (see section 12.2.4.1, Changing the Sample
Rate).

e The power button to the right stops and starts REAKTOR's audio engine. If the audio com-
ing from an Ensemble cuts out unexpectedly, sometimes switching the power button off
and on can fix the problem.

2.2.4.1 Changing the Sample Rate

By default REAKTOR uses the sample rate of your audio interface for processing. This is also
the default setting for most Ensembles. However, some Ensembles (e.g. MONARK, ROUNDS)
use a higher sample rate to improve audio quality.

1. Clicking on the sample rate display opens the sample rate drop-down menu.

The Toolbar
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Play Mode vs Edit Mode

— 2p oo (i
+ Host/System (44100 Hz)

Fixed 44.1/48 kHz
Fixed 88.2/96 kHz
Fixed 176.4/192 kHz

Factor 1/4 (11025 Hz)
Factor 1/3 (14700 Hz)
Factor 1/2 (22050 Hz)
Factor 2/3 (29400 Hz)
Factor 3/4 (33075 Hz)
Factor 4/3 (58800 Hz)
Factor 3/2 (66150 Hz)
Factor 2/1 (88200 Hz)
Factor 3/1 (132300 Hz)
Factor 4/1 (176400 Hz)

The sample rate setting in the toolbar

The sample rate menu contains a number of entries, organized in three categories:

e Host/System: This entry sets REAKTOR to operate at the same sample rate as your audio
interface. This is the default setting for most Ensembles.

e Fixed:: The fixed entries are multiples of your audio interface’s sample rate. They can be
saved with the Ensemble and are used to improve the audio quality. Keep in mind that
higher sampling rates require more CPU.

e Factor:: These entries allow you to reduce or increase the sample rate in the current RE-
AKTOR session.

2.3  Play Mode vs Edit Mode

REAKTOR has two modes of operation:

e Play Mode: This mode optimizes REAKTOR for loading and playing Ensembles and Racks.
It decreases loading times and streamlines the interface, but removes the options for
deep editing of Ensembles and Instruments. This mode is especially useful when using
REAKTOR in a DAW or host.
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Getting to Know REAKTOR
File Types and Hierarchy

e Edit Mode: This mode gives you access to all of the controls and options REAKTOR has to
offer, allowing you to create or edit Ensembles and Instruments.

1. To toggle Edit Mode on or off, click on the EDIT button in REAKTOR's toolbar.
©O. REAKTOR - »

Ens - Rounds

ROUNDS

#

2.4  File Types and Hierarchy

REAKTOR uses several distinct file types, each representing a different structural level in the
application. These levels help to organize your REAKTOR projects in a meaningful way, and
the corresponding files can be used to share aspects of your work between projects or with oth-
er users.

Ensembles

At the top level is the Ensemble, which holds all relevant information of a REAKTOR session. It
represents the basic project file you are working with in REAKTOR. An Ensemble can contain a
single instrument or a full suite of sequencers, synthesizers, and effects. Pre-built instruments
and effects also come as Ensembles, ready to be used in your music or sound design projects.
Ensembles are saved as *.ens files.
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A REAKTOR Ensemble containing one Instrument

Racks

Getting to Know REAKTOR
File Types and Hierarchy

120.0

Racks facilitate analog-style modular synthesizer patching using pre-built modules in the
Blocks format. In a Rack, you can arrange, connect, and control Blocks directly in the Panel.
The patch is also mirrored in the Structure, allowing you to choose your preferred patching
workflow. All settings including the arrangement of Blocks and the connections made between
them are saved and recalled with your host sequencer project (host chunk saving). Racks are

saved as *.nksr files.
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File Types and Hierarchy
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A REAKTOR Rack containing Blocks

@ Information about Racks can be found in the Getting Started and REAKTOR Blocks
Manual documents.

Instruments

An Instrument is a container for a synthesizer, sequencer, an effect, or any other musical tool
you create, representing the so-called Primary level of REAKTOR. It includes the internal
Structure, MIDI processing, Panel (user interface), and Snapshots (presets) associated with
your musical tool. In order to connect an Instrument with REAKTOR’s audio inputs and out-
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File Types and Hierarchy

puts, it has to be loaded in an Ensemble. You can combine multiple Instruments in one En-
semble. In REAKTOR Blocks, each module is a separate Instrument, allowing you to patch be-
tween multiple modules within an Ensemble or a Rack. Instruments are saved as *.ism files.

©. REAKTOR o Default 1200

E

Func

UNISON

A REAKTOR Instrument containing several Macros.

Information about Instruments can be found in the Getting Started and Diving Deeper
documents.

Modules and Macros

Instruments are created using Modules. These are REAKTOR’s basic building blocks. Modules
can be organized into containers called Macros. This is especially useful if your Instrument
consists of a complex structure with a large number of Modules. Macros can be saved as *.md|
files.
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&. REAKTOR Default 120.0

; EVENT LOOPS _
Enable

delv A J'

A REAKTOR Macro containing several Modules and another Macro.

@ Information about Modules and Macros can be found in the Building in Primary docu-
ment.

Core Cells

Core Cells are a way of creating your own DSP modules using REAKTOR’s visual programming

language. Core is the most advanced level of programming in REAKTOR. Core Cells can be
saved as *.rcc files.

©. REAKTOR p Default 120.0

% e—teOut ®

A REAKTOR Core Cell.

@ Information about Core Cells can be found in the Building in Core document.
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2.5  Third-Party and Protected Content

Third-party developers are welcome to develop official content products for REAKTOR. These
products are activated using Native Access.

Find information about installing and activating third-party content products for REAK-

TOR using Native Access in the following article on our website: https://support.native-
instruments.com/hc/articles/115004430405

After installing and activating your third-party content product, you will find it in the Player tab
of the Browser, sorted by vendor:

©. REAKTOR o

SLOO

Shed Loads Of Oscillators

A (D)
G) (&

The Player tab containing content by Native Instruments and third-party developer Tim Exile

Blocks Content for Use in Racks

Blocks need to be officially licensed for use in REAKTOR Racks. After obtaining the license for
an official Blocks content product you can install it via Native Access. After the installation,
the included Racks and Blocks are shown in the Browser’s Player tab, as well as the Library
tab and the search box when a Rack is loaded.
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Content Protection

Any official REAKTOR content product from third-party developers and Native Instruments can
be protected. This means that the Structure of the Ensemble — or Instrument in the case of a
protected module for REAKTOR Blocks — cannot be accessed by the user. As a user, you will
notice the following restrictions:

e |f you load a protected Ensemble into REAKTOR’s Full mode, you will not be able to ena-
ble Edit Mode. The EDIT button will be greyed out, as if you were loading an Ensemble
into REAKTOR’s Player mode.

e |f you add a protected Instrument (module for REAKTOR Blocks) to an Ensemble, you will
not be able to access the Structure of the added Instrument.

e |f you import a protected Ensemble into another Ensemble, you can still enable Edit
Mode, however you will not be able to access the Structure of the imported Ensemble.

@ If you add a protected Instrument or import a protected Ensemble, the Properties for the
Instrument or Ensemble are still available. For example, this allows you to setup MIDI
and OSC control.

Samples that are embedded into a content product can also be protected. In this case, you will
notice the following restrictions:

e Embedded samples are marked as [Copy Protected Content] in the Sample Map Editor,
showing a lock icon in the Embed column of the Sample List.

e Certain functions are disabled in the context menu and the corresponding buttons are
greyed out.

@ If you are a developer and want to contact Native Instruments about your content prod-
ucts, please use the email address provided on the following website: https://www.na-
tive-instruments.com/en/specials/komplete/developer/
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3 Setting Up REAKTOR

In order to be able to send and receive audio as well as interact with the REAKTOR stand-
alone application, you need to configure your audio and MIDI hardware devices (i.e. audio in-
terface, MIDI keyboard) in REAKTOR’s Audio and MIDI Settings. When using the REAKTOR
plug-in, these settings are taken over by the host software. In this case, REAKTOR automati-
cally connects with the host software in order to send and receive audio and MIDI.

When you first open the REAKTOR stand-alone application, the Audio and MIDI Settings win-
dow appears, prompting you to make the required settings:

Audio Routing MIDI )
Driver [ AsIO -
Device [ASID Canfig] [TraktorAudio & v]
Status Running
Sample Rate [44100 v]
Latency 128 Samples
Inpuis 5.4 ms Processing » 2.9 ms Outpui » 4.4 ms | Overall » 127 ms

| € Cancel | | @ oK |

The Audio and MIDI Settings window

3.1 Audio Settings

The audio settings are located in the Audio and MIDI Settings window.

1. To access the audio settings, open the File menu and select Audio and MIDI Settings...
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The first tab in the Audio and MIDI Settings window is the Audio tab, which contains the main
audio preferences. This is where you select your audio interface and adjust its settings for use
with REAKTOR.

Audio Routing MIDI ("
Driver (Asio -]
Device [ASID Canfig] [Tralr.tnrAudin 6 v]
Status | Running |
sample Rate (44100 -
Latency 128 Samples
Inpuis 54ms | Processings 29 ms | Outpui» 44 ms | Overall » 127 ms

|:0l:ancel | | @ OK |

The Audio tab in the Audio and MIDI Settings window

The options presented in this tab are ordered in such a way as to lead you through the audio
set up process. Follow the steps below to set up your audio interface:

1. Select the type of driver you want to use from the Driver drop-down menu. On computers
running Windows, using ASIO is highly recommended. On computers running OS X, Core
Audio is pre-selected.

2. Select your audio interface from the Device drop-down menu. The devices available in
this menu depend on your Driver type selection.

3. Check the Status of your audio interface. If the hardware is connected and working, this
area shows the message Running.

4. Set the Sample Rate for your audio interface. Sample rates of 44100 and 48000 Hz are
commonly used and recommended. If you are using an ASIO driver on a Windows system,
click on the ASIO Config button to access the ASIO settings for your audio interface and
set the sample rate.
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5. Set the Latency for your audio interface. Latency refers to the period of time the computer
needs to process an audio signal. It is determined by the size of the audio buffer (in sam-
ples). Buffer sizes of 128 and 256 samples are commonly used and recommend.

If the computer is not able to provide the amount of processing power needed to com-
plete all audio calculations in time, crackles and drop-outs in the audio playback might
occur. In this case, gradually increase the size of the audio buffer until the playback is
clean.

Setting up the Audio Routing

After you have completed setting up your audio interface in the Audio tab, you can then
choose which audio inputs and outputs REAKTOR should use in the Routing tab. This is where
you connect REAKTOR’s inputs and outputs to the inputs and outputs of your audio interface.

Audio Routing MIDI ("
[ Inputs | Outputs |

Reaktor 1 1: Main Left
Reaktor 2 2: Main Right
Reaktor 3 - not connected -
Reaktor 4 - not connected -
Reaktor 5 - not connected -
Reaktor & - not connected -
Reaktor 7 - not connected -
Reaktor 8 - not connected -
Reaktor 9 - not connected -
Reaktor 10 - not connected -

|:0l:ancel | | @ OK |

The Routing tab in the Audio and MIDI Settings window
The Routing tab has two pages:
e [nputs: On this page you can manage the connection options for REAKTOR's inputs.

e Qutputs: On this page you can manage the connection options for REAKTOR's outputs.
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REAKTOR can have multiple inputs and outputs. Most of the time you will only need to use
two of each (for the left and right stereo channels), but in some cases more outputs are re-

quired. For example, an Ensemble hosting multiple Instruments can benefit from individual
outputs for each of them.

To set the audio inputs:
1. Click on the Inputs tab.

Audio Routing MIDI

[ inputs [|outputs |

Reaktar 1 1: Main Left
Reaktor 2 2: Main Right

2. Click on the area labeled - not connected - beside the REAKTOR input you wish to define.

[ Inputs | Outputs |

Reaktor 1 1: Main Left
Reaktor 2 2: Main Right
Reaktor 4 - not connected -
Reaktor 5 - not connected -
Reaktor 6 - not connected -

3. Select the input you wish to use from the menu.

[ Inputs | Outputs |
Reaktor 1 1: Main Left
Reaktor 2 2: Main Right
Reaktor 3 - not connected -
Reaktor 4 - not connected -
Reaktor 5 1: Main Left
Reaktor 6 2: Main Right
Reaktor 7 3: Ch A left
Reaktor 8 4: Ch Arigh
Reaktor 9 5: Ch B left
Reaktaor 10 6: Ch B right
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To set the audio outputs:

1.

Click on the Outputs tab.

Audio Routing MIDI
[ Inputs || Outputs
Reakror 1 1: Main Left
Reaktor 2 2: Main Right

Click on the area labeled - not connected - beside the REAKTOR output you wish to de-

fine.

[ Inputs | Outputs)

Select the output you wish to use from the menu.

Reaktor 1
Reaktor 2
Reaktor 3
Reaktor 4
Reaktor 5
Reaktor 6

1: Main Left
2: Main Right

- not connected -
- not connected -
- not connected -

[ nputs | Outputs |

Reaktor 1
Reaktor 2
Reaktor 3
Reaktor 4
Reaktor 5
Reaktor 6
Reaktor 7
Reaktor 8
Reaktor 9
Reaktor 10

1: Main Left
2: Main Right
- not connected -
- not connected -
1: Main Left
2: Main Right
3: Ch Aleft
4:Ch A righ%
5: Ch B left
6: Ch B right
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1. Once you have completed the Audio settings as well as the Inputs and Outputs selection
process, click the OK button to confirm your settings.

Audio Routing MIDI (o
[ Inputs | Outputs
Reaktor 1 1: Main Left
Reaktor 2 2: Main Right
Reaktor 3 3: Ch A left
Reaktor 4 4: Ch Aright
Reaktor 5 - not connected -
Reaktor 6 - not connected -
Reaktor 7 - not connected -
Reaktor 8 - not connected -
Reaktor 9 - not connected -
Reaktor 10 - not connected -
| @cancel ||| ok |

3.2  MIDI Settings

The MIDI settings are located in the Audio and MIDI Settings window. To access the MIDI set-

tings:

1.  Open the File menu and select Audio and MIDI Settings...
2. Click on the MIDI tab.

The MIDI tab contains the main MIDI preferences. This is where you enable your MIDI devices
for use with REAKTOR, for example MIDI keyboards, USB MIDI controllers, or MIDI interfaces.
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Audio Routing MIDI ("
[ Inputs |l:lutput5]
Device name Status
LoopBe Internal MIDI Off
Maschine Mikro MK2 In Off
|' © Cancel | | @ OK |

The MIDI tab in the Audio and MIDI Settings window

The MIDI

* [npu

tab has two pages:

ts: On this page you can select the devices which REAKTOR receives MIDI data from.

e Qutputs On this page you can select the devices REAKTOR sends MIDI data to.

Both of these pages show similar looking tables with the same columns:

e Device name: This column shows a list of the MIDI devices connected to your computer.

e Status: This column shows the current On/Off state of the device.

To enable MIDI data being received from a MIDI device (for example a MIDI keyboard):
1. Click on the Inputs tab.

[ inputs ||outputs |

Device name
LoopBe Internal MIDI
Maschine Mikro MK2 In
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[ Inputs | Outputs |

Device name
LoopBe Internal MIDI
Maschine Mikro MK2 In

3. Select On from the menu.

Device name
LoopBe Internal MIDI
Maschine Mikro MK2 In

Status

Off

Status
Off
Off

Off

on

= REAKTOR now receives MIDI data from the MIDI device.

You can test if the connection is working by sending MIDI data to REAKTOR (e.g. by
pressing keys on your keyboard) and checking if the MIDI indicator in the Toolbar is

blinking (see section 12.2, The Toolbar).

To enable MIDI data being sent to a MIDI device (for example a MIDI-controlled synthesizer):

1. Click on the Outputs tab.

[ Inputs || Outputs

Device name

Microseft GS Wavetable Synth
LoopBe Internal MIDI
Maschine Mikro MK2 Qut

2. Click on the Status of the device you wish to use.

[ Inputs | Outputs |

Device name

Micresoft G5 Wavetable Synth
LoopBe Internal MIDI
Maschine Mikro MK2 Qut

Status

Off
Off
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3. Select On from the menu.

Device name Status
Microseft GS Wavetable Synth Off
LoopBe Internal MIDI Off
Maschine Mikro MK2 Out On

= REAKTOR now sends MIDI data to the MIDI device.
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4 REAKTOR as a Plug-in
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REAKTOR as a plug-in

A common use case for REAKTOR is loading it as a plug-in in a host sequencer. When using
the REAKTOR plug-in in a host sequencer project, you typically make changes to the Ensem-
ble by tweaking its knobs and other Panel elements. These changes are saved as part of your
host sequencer project.

The same applies to using REAKTOR Racks for patching with Blocks. All settings including the
arrangement of Blocks and the connections made between them are saved and recalled with
your host sequencer project.
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When working with an Ensemble, the REAKTOR plug-in also stores a link to the loaded Ensem-
ble file. When you re-load a host project, REAKTOR looks for the Ensemble file, loads it, and
then applies any control changes you may have made.

By default, the REAKTOR plug-in opens in Play Mode, meaning that the Ensemble Structure
and the Ensemble’s advanced settings are locked. This protects any loaded Ensemble, allowing
you to use it as an instrument or effect without needing to worry about accidentally altering the
Ensemble and losing the changes you may have made.

You can still enter Edit Mode in the REAKTOR plug-in and make changes to the Structure or
the Ensemble’s advanced settings, but this means you will need to save and manage your En-
semble file in addition to your host sequencer project (see section 14.1, Editing Ensembles
and Automatic Saving).

4.1  Editing Ensembles and Automatic Saving

When you are using the REAKTOR plug-in in Edit Mode and the Ensemble is modified in such
way that the changes are not saved in the host sequencer’s project, the Save Ensemble button
in the Toolbar turns red, indicating that these changes will be lost when closing the project:

©. REAKTOR J) My Snapshot*

[ @]
- Kontour Panel

B Ens - Kontour

KONTSUR ™™

* +

The red Save Ensemble Button

To preserve the changes you have made, you need to create a local copy of the Ensemble. A
link to this local copy is saved in the host sequencer’s project and the Ensemble will be auto-
matically loaded the next time you open the project.

To save a local copy of the Ensemble:
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1. Click on the Save Ensemble button in the Toolbar.

©. REAKTOR b My Snapshot*

Ens - Kontour
#

P KONTOUR o

Metallic E th

2. In the file dialog, choose the desired location and name for the local copy of your Ensem-
ble and click Save.

.(;). REAKTOR L Snaps e Ir—|||:||

Sa\re Ensemble As

@ g/ | . % Daten (HD... » My Reaktor Ensembles - | | Search

Organize Mew folder =S - (7]

[ Favorites Mo items match your search.

= Libraries

1M Computer A
&‘ﬂ Metwork
|_H_|
File name: Kontour Ensemble.ens| -
Save as type: ’Ensemble (*.ens) v]
2 Hide Folders | sae %J | Concel
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= A local copy of your Ensemble is saved and the Save Ensemble button turns from red to
grey, indicating that all changes have been saved.

©. REAKTOR L My Snapshot*®

Panel

B Ens - Kontour

KONTOUR

The next time the Save Ensemble button turns red to indicate that changes will be lost
when closing the project, you can simply click on it to save the changes to your previ-
ously created local copy.

Enabling Automatic Saving

You can also enable automatic saving of the Ensemble. Again, a local copy of the Ensemble is
created, however it is saved automatically every time you save the host sequencer’s project.
This way, you do not have to keep track of the save status of the Ensemble as long as your host

sequencer’s project is saved correctly.
To enable automatic saving of the Ensemble:
1. Click on the Enable Automatic Saving with Host button in the Toolbar.

©. REAKTOR P My Snapshot 1*

Ens - Kontour £ 045 My Snapshot 1*

KONTOUR ™ @

REAKTOR 6 - Getting Started - 40



REAKTOR as a Plug-in

Editing Ensembles and Automatic Saving

2. In the file dialog, choose the desired location and name for the local copy of your Ensem-
ble and click Save.

&. REAKTOR p o) My Snapshot 1*

Organize » Mew folder
W Favorites No items match your search,
4 Libraries

18 Computer

9‘ Metwork

File name: Kontour Ensemble.ens|

Save as type: ’Ensemble (*.ens) v]

“ Hide Folders l §EVEQJ l Cancel ] J

= The Enable Automatic Saving with Host button lights up, indicating that automatic saving
of your Ensemble is now enabled. The local copy of the Ensemble is saved every time you
save your host sequencer’s project, and will be automatically loaded the next time you
open the project.

You can disable automatic saving by clicking on the lit Enable Automatic Saving with
Host button. This resets the automatic saving, and you can click on the button again to
enable automatic saving with a new local copy of your Ensemble.
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4.2  Resolving a Broken Ensemble Link

Since the REAKTOR plug-in loads the Ensemble that linked in your host sequencer project
from an external file, it is possible for the link to the Ensemble to become broken, for example
if you rename the folder where the Ensemble is located.

If this happens, REAKTOR reports that it cannot find the linked Ensemble and asks you locate
it:

©. REAKTOR L Untitled Snapshot

Ensemble Not Found

C:\Users\is bssa\Desktop\My Molekular Ensemble.ens

LOCATE ENSEMBLE

REAKTOR Ensemble not found

To locate the Ensemble file and re-establish the link, follow the instructions below:
1. Click the LOCATE ENSEMBLE button.

Ensemble Not Found

Chilsers\ @ bwwn\Desktop\My Molekular Ensemble.ens

IGNORE LOCATE EMSEMELE

3
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2.

In the file dialog, navigate to your Ensemble file and select it.

C\lsersije s i = =\Desktop\My Molekular Ensemble.ens

Please locate My Molekular

f\. | < Daten (HD... » My Reaktor Ensembles - Search Reaktor Ens es 0O

Organize - Mew folder

.0 Favorites My Molekular Ensemble.ens
ENS File
131 MB

- Libraries

1% Computer

ﬁhj Network

File name: My Molekular Ensemble.ens - ’Reak‘tor Ensembles (*.ens;*.rkpl v]

[ open || canca |
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3. Click open to confirm your selection.

CAUsers\ji= i \Des 'y Molekular Ensemble.ens

Please locate My Malekular Ense

Organize - Mew folder

.0 Favorites My Molekular Ensemble.ens
ENS File
131 MB

4 Libraries

L5 Computer

cj Metwork

File name: Wy Molekular Ensemble.ens - IReak'tor Ensernbles (*.ens;™.rkpl v]

Open M l Cancel ]
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= The Ensemble is loaded, and the re-established link can be saved in your host sequencer
project.

.(:). REAKTOR My Molekular Snapshot o

A

Ens kular

Input

LOGIC ROUTING
1230 )
O x x
. v ) 0 ¢°
Q Y Delay Filter  Level

PATCH
vOo

v © O | Cloud Delay

Plagiarism v @& O | Frequency Shift v © O | Metaverb

Freq Map Pitch Random Depth ay Pitch i L Shift Up/Down R Shift

[ 1hz Qi Link ]

’. Attack Hnld Release Jitter Cloud Dnnshy FB FB Mix Time
11

| we wad @ @D we wil o @D we wed @ @D wd wid e

Alternatively, you can click the IGNORE button to permanently break the link to the En-
semble file and start using REAKTOR from scratch.
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9 Browsing and Loading Ensembles

Ensembles are the main file type used for final REAKTOR instruments and effects. There are a
number of ways to browse for and load Ensemble (*.ens) files.

Drag and Drop
The most basic way of loading Ensemble files is via drag and drop:

1. Using your operating system's file browser, locate the Ensemble file you wish to load.

Organize = Include in library = Share with = Burn MNew folder

My Kentour Ensemble.ens

0 Favorites .
ENS File
120 ME

4 Libraries

18 Computer

“ﬂ MNetwork
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2. Click on the Ensemble file and drag it into the empty main area in REAKTOR's interface.
If you have already loaded an Ensemble, you have to drag the Ensemble file into the Pan-
el of the existing Ensemble.

Untitled Snapshot

« Daten... » My Reaktor Ensembles

Organize v [®] open ~ Burn New folder

¢ Favorites My Kontour Ensemble.ens
()] ensFie

120 MB
= Libraries

™ Computer

€ Network

e My Kontour Ensemble.ens Date modified: 24.08.2015 16:46
B s Size: 120 MB

3. Release the mouse button.
= REAKTOR will load the Ensemble file.

If you drag an Ensemble file into the Structure of an existing Ensemble, it will be added

to the existing Ensemble as an Instrument.

File Menu

You can also open Ensembles via the main menu:
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Click on the arrow next to the REAKTOR to open the main menu.

©. REAKTOR ™ P
0

Player Files

@
B3 Kontour

Go to the File menu and select Open Ensemble...

&. REAKTOR ~ »

Jo) File
Edit
Settings

Player

Options

View
Help

Untitled Snapshot

MNew Ensemble
Open Ensemble ... I}
Recent Files

Sawve Ensemble

Sawve Ensemble As ...

Save Ensemble Copy As ...
Show in Folder

Browsing and Loading Ensembles
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3. In the file dialog, navigate to your Ensemble file and select it.

1]

Untitled Snapshot 30.0 osc

[ &, Open Ensemble . ! |
'i-\ Q/ . <« Daten (HD... » My Reaktor Ensembles - Jn‘p

Organize * New folder

. My Kontour Ensemble.ens

» .0 Favorites QJ Ere F
- ' N File
1 120 ME I}

* |70 Libraries
> /M Computer

>'Ei_i Metwork

File name: - ’Reak‘tor Ensembles (*.ens;* rkpl v]

[ open || cancel |
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4. Click open to confirm your selection.

Untitled Snapshot

I .| Open Ensemble . | |
/(:.' 3] | .« Daten (HD... » My Reaktor Ensembles v |+

Qrganize « Mew folder
.0 Favorites — My Kontour Ensemble.ens
SO|| EMSFile

120 MB
o Libraries

M Computer

Gi_i MNetwork

File name: My Kontour Ensemble.ens - ’Reak‘torEnsembles(*.ens;*.rkpl v]

| Open | [ concel |

= REAKTOR will load the selected Ensemble.
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Instrument Header

b Using Ensembles and Instruments

An Instrument is a container for a synthesizer, sequencer, or an effect in REAKTOR. In order to
connect an Instrument with REAKTOR'’s audio inputs and outputs, it has to be loaded in an
Ensemble. An Ensemble holds all relevant information of a REAKTOR session. It represents
the basic project file you are working with in REAKTOR. An Ensemble can contain a single in-
strument or a full suite of sequencers, synthesizers, and effects. If you open an Instrument
from the Browser’s Player tab, it automatically loads in an Ensemble and can be used immedi-
ately.

See also
A/B View [+ 52]
Snapshots and Presets [ 53]

6.1 Instrument Header

The Instrument Header is located at the top of the panel of any Instrument you load into RE-
AKTOR.

.(;); REAKTOR o Unicorn*

Ens - Kontour & 027 Unicorn*

KONTOUR

m COLOR1 COLOR 2 LOUDMESS
» L] u L] u L] » L]
The Instrument Header

(1) A/B View: Selects A or B view for the Instrument. See section 16.2, A/B View 16.2, A/B
View for more information on these controls.
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(2) Minimize: Hides the Instrument Panel to show only the Instrument Header. Clicking on this
button again will reveal the Instrument Panel.

(3) Instrument Name: Displays the name of the Instrument.

(4) Snapshot Menu: A menu for loading Instrument Snapshots. See section 16.3, Snapshots
and Presets 16.3, Snapshots and Presets for more information on Snapshots.

(5) MIDI/OSC Indicators: A set of 4 activity indicators, which light up whenever the Instrument
sends or receives MIDI and OSC messages.

(6) Polyphony Info: Shows the number of voices used by the Instrument. Generally this equates
to the number of notes that the Instrument can produce at once, but this may not always be
the case.

The Instrument Header can contain any combination of the described controls and dis-
plays, or even not be shown at all for specific Instruments.

6.2 A/BView

REAKTOR Instruments can have two different Panel layouts, which are called the A view and
the B view. Not all Instruments use this feature.

Generally the A view is the main view, featuring the main controls needed to use the instru-
ment or effect.

The B view can be any number of things. MONARK for example uses the B view for the set-
tings, MOLEKULAR uses the B view for a simplified interface, and KONTOUR uses the B view
to display the full set of controls.
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Snapshots and Presets

1. You can select to view the A or B views by clicking on the A and B buttons in the Instru-
ment Header.

'é' REAKTOR Unicorn®

n ns - 7 Unicorn® - Voices:

i Ens - Kontour
DRAMA COLOR1
- v [+ o -

MOD ASSIGNMENT

2 IR B SHAPER

6.3  Snapshots and Presets

Snapshots and Presets, which are REAKTOR's sound preset formats used with Ensembles and
Instruments, enable you to store and recall the state of Panel controls. When you recall a
Snapshot, all the Panel controls are restored to the state they were in when the Snapshot was
originally created.

Most pre-built Ensembles include a number of Snapshots for the included Instruments, ready
to be used in your music. Each REAKTOR Instrument can store 16 Snapshot Banks containing
128 Snapshots each, for a total of 2048 Snapshots.

While both Snapshots and Presets accomplish the same thing on the surface, the details of
their use and function differ:

e Snapshots are embedded in the Ensemble file, whereas Presets are external files.
e Snapshots can be recalled using MIDI Program Change messages.

e Presets can be saved when using REAKTOR is Play mode; Snapshots are written into the
Ensemble file, and so REAKTOR must be on Edit mode in order to create new Snapshots.

e Presets save the state of the Ensemble, whereas Snapshots can be per Instrument.

e An Ensemble can contain only a limited number of Snapshots (2048).
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Recalling Snapshots

For more information about Snapshots in REAKTOR, refer to the Diving Deeper docu-
ment.

6.4 Recalling Snapshots

You can recall Snapshots from several locations:

e The Snapshot menu in REAKTOR's Toolbar: This method recalls Snapshot settings for all In-
struments in an Ensemble.
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e The Instrument Header: This method recalls Snapshot settings for this particular Instru-
ment only.
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e The Presets tab in the Side Pane: Clicking on the camera icon labelled Embedded will dis-
play the Snapshot Banks contained in an Ensemble/Instrument. This area gives you a bet-
ter overview over the available Snapshots for the selected Instrument. In Edit Mode, the
Snapshot tab allows you to store and edit your own Snapshots (see section 16.5, Storing
Snapshots ).

|[.:‘I+ Embedded

3

2 "User

e Via MIDI: REAKTOR can accept Program Change messages and use them to select Snap-
shots. The MIDI Program Change message selects a Snapshot by its number (an integer in
the range [0 ... 1271). A Program Change value of “0” selects the first Snapshot; a Pro-
gram Change value of “1” selects the second Snapshot, and so on.

6.5  Storing Snapshots

Storing and editing Snapshots can be done from the Snapshots tab in the Side Pane.

1. In order to be able to store and edit Snapshots, enable Edit Mode by clicking on the EDIT
button in the Toolbar.

&. REAKTOR

all Tl=ila

When viewing Snapshots in the Presets pane, there are three buttons at the bottom for storing
Snapshots:
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©. REAKTOR o
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The buttons to Add, Store, and Insert Snapshots

e Add: Creates a new Snapshot with the current settings of your Instrument at the end of
the Snapshot list.

e Store: Overwrites the currently highlighted Snapshot with the current settings of your In-
strument.

e |nsert: Creates a new Snapshot with the current settings of your Instrument directly after

the currently highlighted Snapshot, moving any other Snapshots down one slot in order to
make space.

Snapshots are stored in the Ensemble, so you need to save the Ensemble or Instrument
in order to make changes to the Snapshots permanent.
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6.6  Presets

REAKTOR Preset files are a single Snapshot, saved as an external file. Presets contain a link to
their original Ensemble file, which is automatically loaded as soon as the Preset file is opened.
If the Ensemble file is already open, then the Preset is loaded like a Snapshot.

Presets can also be saved and loaded when using REAKTOR PLAYER, or the full version of RE-
AKTOR when in Play Mode.

Preset files can be saved and loaded via the Files menu:

1. To save a preset, go to the main menu and select File > Save Preset As ....This opens a
dialog window asking you choose a location and a name for the new Preset file.

2. To load a preset, go to the main menu and select File > Open Preset .... This opens a
dialog window asking you choose a Preset file from your hard drive to load.

Presets can also be saved and loaded via the Presets tab of the Side Pane.

Creating Presets and Folders in the Presets Tah

As an example, this section will walk through the process of creating a Preset folder and saving
Presets into that folder.

1. Click on the list icon to open the Presets tab in the Side Pane.

Mew Folder
Move to Trasl'lk

Show in Folder

Presets
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3. When the folder appears, you are able to name it. Type in the name My Presets and press
Enter.

= The My Presets folder will appear in the Presets folder list.
Now that you have a Presets folder created, it is time to populate it with Presets.
To create a Preset:

1. Select the folder into which you wish to store the Preset.
2. Click on the Add button at the bottom of the Presets tab.

3. Type a name for the Preset.

4. Press Enter to save the Preset.
= The Preset will be saved and added to the selected Preset folder.

To overwrite a saved Preset:

1. Select a Preset from the Presets list.

2. Click on the Store button at the bottom of the Presets tab.

= The selected Preset will be overwritten with the current settings.
Deleting Presets and Folders

To remove a Preset or Folder:

1. Right-click on the item you wish to delete.
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If you delete a Folder, you will also delete all Presets contained within it.

Select Move to Trash from the menu.

| This is a bad Preset

Move to Trash
Show in Folder
Sort By

This is a Preset

Using Ensembles and Instruments

Presets

A window will pop up asking you to confirm the action; click OK to confirm.
= The Preset or Folder will be deleted.

Also note that this deletion is not permanent, as the Preset files and folders are move to your
operating system’s recycle bin, and so can be restored or permanently deleted from there.

Managing Presets outside REAKTOR

Since Presets and Preset folders exist as files and folders on your hard disk, they can be man-
aged from there as well. You can rename, sort, and delete Presets without even having REAK-
TOR open.

User presets are located in the following directories:

On Windows: C:\Users\<User>\Documents\Native Instruments\User Content\Reaktor\<En-

semble Name> \

On OS X: Macintosh HD:\Users\<User>\Documents\Native Instruments\User Content\Re-

aktor\<Ensemble Name> \

Powered by REAKTOR products (like THE MOUTH or ROUNDS) will have their own folders be-

side the Reaktor folder, as they are managed as their own products.

You can jump to these locations from within REAKTOR:

1.

To view the Preset or folder in your operating system’s file browser, right-click on it and

select Show in Folder.

=
32 User

| Im My Presets

MNew Folder
Move to Trash

Show in Folder
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= A window will open displaying the location of the folder or Preset on your hard disk.

If you are managing Presets outside REAKTOR, it is advised that you have REAKTOR or the
target Ensemble closed while you do so.
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Overview

1 Using Racks

Racks facilitate analog-style modular synthesizer patching using pre-built modules in the
Blocks format. In a Rack, you can arrange, connect, and control Blocks directly in the Panel.
The patch is also mirrored in the Structure, allowing you to choose your preferred patching
workflow.

This chapter provides an overview of the Racks and explains how to manage them. If you want
to learn more about Racks and all the available Blocks, refer to the following resources:

e |earn how to patch using REAKTOR Blocks in a Rack by following the Quick Start Guide
online: www.native-instruments.com/reaktor-blocks-quickstart

e [earn all about the Blocks and their controls in the application by using REAKTOR’s Info
Hints. For more information, refer to 17.1, Overview.

1.1 Overview

The following overview shows you how a Rack is displayed in REAKTOR and where you can
find the most important controls.
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Overview of a Rack in REAKTOR

(1) Library: This tab in the Browser shows all installed Blocks. They are organized in folders.
The contents of the selected folder are shown in the lower section of the Browser. You can drag
and drop the Blocks from the lower section into the Rack to build your patch.

(2) View modes: These three buttons control the visibility of ports and wires in the Rack.

e Compact View: All ports and wires are hidden. You can focus on tweaking the controls of
the Blocks.

e Ports View: Only the wires are hidden. You have a clear view of all controls while the ports
are still visible, indicating connections in the patch by color coding.

e Ports and Wires View: The full patch including ports and wires is visible and can be
changed by making new connections or removing existing ones.
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(3) Show Structure: This button shows or hides the additional Structure view (8). This is useful
for creating and managing large patches. The Structure shows all connections even when Com-
pact View or Ports View are selected.

(4) Rack switching: The arrow buttons in the Rack menu switch between Racks in the selected
category folder of the factory content. For more information, refer to 17.2, Loading Racks.

(5) Panel view: Shows all Blocks in the Rack. You can change the controls on each Block to
adjust its parameters. Inputs are located on the left side of a Block, while outputs are located
on the right side. You can connect Blocks by clicking on an output and dragging a wire to an
input. You can remove a wire by double-clicking on the connected input.

(6) Info Hints: Enables or disables tooltips for all Blocks and their controls. When enabled, you
can hover over the header of a Block to view general information. Hovering over a control shows
detail information.

(7) Search box: Press the Enter key on your computer keyboard to call up the search box. You
can find Blocks by entering their function, family, or name. The search box can be used both
in Panel and Structure views.

(8) Structure view: Shows all Blocks in the Rack. Inputs are located on the left side of a Block,
while outputs are located on the right side. You can connect Blocks by clicking on an output
and dragging a wire to an input. You can click on a wire to select it and press Delete or Back-
space on your computer keyboard to delete a wire.

1.2 Loading Racks

Each Blocks product includes premade Racks as factory content. You can load these Racks
from the Player tab in the Browser. Alternatively, you can open Racks saved on your hard drive.

Loading Racks from a Blocks Product

To load a Rack included in a Blocks product:
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1.  Open the folder of the Blocks product in the Browser’'s Player tab, select a category folder
and load a Rack by double-clicking on it in the lower section.

5. REAKTOR

Once you have selected a category folder, you can also switch between Racks using the Rack
menu in the toolbar.

1. Click on the arrows in the Rack menu to switch between Racks in the selected category
folder.

Subtractive Synthesis

ADSR - Filter
@ Env .
N — g - J|i
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Opening a Rack saved on the Hard Drive

To open a Rack saved on the hard drive:
1. Click on the drop-down menu next to the REAKTOR logo, go to the File menu and select
Open.

&. REAKTOR ~ »

Mew Ensemble
Mew Rack
Open ..

Recent Fites

Library

Save
; Save As ... %
b Util Save Rack As Ensemble ... b | .
2. Inthe file dialog, browse to the Rack file you saved, select it, and click Open.

= The Rack opens in REAKTOR and you can start using it.

1.3 Saving Racks

When you have created a sound you like, you can save your Rack in a file. This way you can
recall it later and share it with others.

1. Click on the drop-down menu next to the REAKTOR logo, go to the File menu and select
Save.

&, REAKTOR ~ »©

yol MNew Ensemble
MNew Rack
Open...
Recent Files »

Player Library

o se Save
B3 Blocks Primes Save %
Save Rack As Ensemble ...
Show in Folder

2. In the file dialog, browse to a location of your choice, type in a name for your Rack, and
click Save.
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Creating a New Rack

When using REAKTOR as a plug-in, all settings including the arrangement of Blocks and
the connections made between them are also saved and recalled with your host se-
quencer project (host chunk saving).

14  Creating a New Rack

When you want to create a Rack from scratch, you need to open a new Rack.

1. Click on the drop-down menu next to the REAKTOR logo, go to the File menu and select
New Rack.

&, REAKTOR ~ »©

yol MNew Ensemble

New Rackh
Open...
Recent Files

Player Library

Save
Save As ..

1.5  Additional Settings

Additional settings for Racks are available in REAKTOR'’s side pane.

e Panel Sets allow you to save different configurations of the Panel view in the same Rack
file. You can show or hide Blocks (while they remain active) or switch between arrange-
ments of Blocks for specific use cases. For more information, refer to the REAKTOR 6
Diving Deeper document, chapter Panelsets.

e You can assign any of the controls in the Rack to your MIDI controller. For more informa-
tion, refer to 19, Controlling REAKTOR.

e You can also use OSC to control your Rack, or route MIDI and OSC data from and to indi-
vidual Blocks in the Rack. For more information, refer to the REAKTOR 6 Diving Deeper
document, chapter Controlling REAKTOR with MIDI and 0SC.
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8 Snapshots and Presets

Snapshots and Presets, which are REAKTOR's sound preset formats used with Ensembles and
Instruments, enable you to store and recall the state of Panel controls. When you recall a
Snapshot, all the Panel controls are restored to the state they were in when the Snapshot was
originally created.

Most pre-built Ensembles include a number of Snapshots for the included Instruments, ready
to be used in your music. Each REAKTOR Instrument can store 16 Snapshot Banks containing
128 Snapshots each, for a total of 2048 Snapshots.

While both Snapshots and Presets accomplish the same thing on the surface, the details of
their use and function differ:

e Snapshots are embedded in the Ensemble file, whereas Presets are external files.
e Snapshots can be recalled using MIDI Program Change messages.

e Presets can be saved when using REAKTOR is Play mode; Snapshots are written into the
Ensemble file, and so REAKTOR must be on Edit mode in order to create new Snapshots.

e Presets save the state of the Ensemble, whereas Snapshots can be per Instrument.

e An Ensemble can contain only a limited number of Snapshots (2048).

For more information about Snapshots in REAKTOR, refer to the Diving Deeper docu-
ment.
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9 Controlling REAKTOR

REAKTOR Instruments can be remotely controlled from a wide range of hardware controllers.
This enables you to play REAKTOR with a physical interface, be it a MIDI keyboard, a special
MIDI controller with knobs and buttons, or a device supporting Open Sound Control.

REAKTOR uses two protocols for sending and receiving control messages:

e MIDI: Musical Instrument Digital Interface - a standard communication protocol for musi-
cal instruments created in the early 80s that is still commonly used today. Virtually all
keyboard controllers use MIDI to communicate with your computer. It is also used by
hosts to communicate with the REAKTOR plug-in.

e 0SC: Open Sound Control - a more modern protocol that offers faster data rates, higher
resolutions, and a more flexible architecture compared to MIDI. However, OSC is less
common and requires a more advanced setup.

This Getting Started document only describes basic MIDI options. Since the MIDI and OSC
functionality is tied together, the following description refers to combined functions in some
cases.

For more information on using the OSC protocol with REAKTOR, refer to the Diving
Deeper document.

9.1 MIDI Learn

In order to be able to remotely control REAKTOR from your hardware controller, its MIDI con-
trols need to be connected to the Panel controls in REAKTOR.

Your hardware controller has to be enabled in REAKTOR's MIDI settings first. See sec-
tion 13.2, MIDI Settings for more information.

The easiest way to connect a MIDI control to a Panel control is the MIDI learn function. It es-
tablishes the connection between the MIDI control and the Panel control in a semi-automatic
fashion.
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Connection Manager

1. Right-click on the Panel control you want to connect the MIDI control to.
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2. Select MIDI & OSC Learn to enable the MIDI learn function.
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3.  Move the MIDI control you want to use.
= The MIDI control is connected to the Panel control, which can now be remotely controlled
from your MIDI controller. The MIDI learn function is disabled automatically as soon as the

connection is established.

9.2  Connection Manager

The Connection Manager is located in the Side Pane. It allows you to manage the MIDI con-
nections in the currently loaded Ensemble.
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Connection Manager

1. To view the Connection Manager, click on the Side Pane tab with the controller icon.
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= The Connection Manager appears in the Side Pane.
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The Connection Manager has two tabs, one for MIDI and one for OSC.

1. When working with MIDI, select the MIDI tab.

All established connections are shown in the list at the top of the MIDI tab. They appear in the
following order:
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MIDI messages in the Connection Manager

(1) Current: The current connections appear at the top of the list. They are identifiable by the
information present in the Target column.

(2) Recent: Recently received messages appear below the current connections (by default, this
list is only refreshed each time you open the tab).

Note messages appear below controller messages, both for current connections as well as for
recently received messages.

1. To view incoming messages in real-time, activate the Auto button below the list. Not only
will this re-populate the list in real-time, but it will also highlight currently used messag-
es.

2. To clear any unconnected controllers from the table, click on the Clean button below the
list.

Creating Connections

You can connect MIDI controls to Panel controls from the Connection Manager by drag and
drop:
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Connection Manager

1. Click on the arrow icon next to the MIDI control you wish to use and keep the mouse but-
ton pressed.

MIDI
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= The MIDI control is connected to the Panel control and appears among the other current
connections at the top of the list.

Alternatively, you can activate the MIDI Learn function from the Connection Manager:
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Connection Manager

1. Click on the Learn button at the top right of the Connection Manager to activate MIDI
Learn.
m
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2. Click on the Panel control you want to connect the MIDI control to.
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3. Move the MIDI control you want to use.

= The MIDI control is connected to the Panel control and appears among the other current
connections at the top of the list.

Monark:Fine k‘

Deleting Connections

You can also use the Connection Manager to remove MIDI connections:
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1. Select the connection you wish to remove by clicking on it in the list.
m
MIDI

CONTROL Ch.

2. Click on the Delete icon below the list or press the [delete] key on your keyboard.

Auto

Midi Out

= The selected connection is removed.

Filtering the Connections List by Controller Data Type
You can filter the MIDI connections list by the data type. The available filters are:
e All: All MIDI message types are shown.
e (CC: Only MIDI CC (Continuous Controller) data is shown.
¢ Note: Only MIDI Note data is shown.
e AT: Only MIDI Aftertouch data is shown.
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1. To filter the list of controller messages by data type, right-click on the Control column's
header and select one of the available data type filters from the context menu.

©. REAKTOR o

Filtering the MIDI List by MIDI Channel
You can also filter the MIDI connections list by MIDI channel.

1. To filter the list of controller messages by MIDI channel, right-click on the Ch (Channel)
column's header and select the MIDI channel from the context menu.

©. REAKTOR o
[#14]
MIDI

Filtering the Lists by Ensemble or Instrument

Finally, you can filter the MIDI connections list so that only controller messages assigned to a
specific Ensemble or Instrument are shown:
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1. To filter the list of controller messages by Ensemble or Instrument, right-click on the Tar-
get column's header and select the Ensemble or Instrument from the context menu.
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9.3  MIDI Clock

If REAKTOR is running as a stand-alone application, it can synchronize its internal clock to
other devices via MIDI clock. This could be hardware such as a drum machines, hardware se-
quencers, synthesizers, and effects processors, or even software running on another computer.

REAKTOR can also synchronize its internal clock to Ableton Link. For more information,
see section 19.4, Synchronization using Ableton Link.

1. To access the MIDI clock settings, go the Settings sub-menu in the REAKTOR main
menu.
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Synchronization using Ableton Link

&. REAKTOR

yol File
Player Library =z
: = Settings Sample Rate
Options Control Rate
View Store Panelset

= Recall Panelset

Automatic Panel Layout
Snap to Grid

Sync to External Clock
Send Clock to MIDI Output
Set BPM by Snapshot

Turn off Reaktor 4 Legacy Mode

The MIDI clock settings

(1) Sync to External Clock: When enabled, all Sync Clock and 1/96 Clock modules synchronize
to MIDI clock received on any of the active MIDI inputs (see section 13.2, MIDI Settings for
information about changing the status of MIDI inputs). In this case, the BPM value of REAK-
TOR’s transport in the toolbar cannot be adjusted manually; instead, the internal clock is auto-
matically adjusted according to the external clock. Sync to External Clock also allows for con-
trol of Start/Stop modules by external MIDI-Start/Stop messages.

(2) MIDI Clock Out: When enabled, REAKTOR’s transport sends out MIDI clock ticks on all ac-
tive MIDI outputs inputs (see section 13.2, MIDI Settings for information about changing the
status of MIDI outputs). Note that playback needs to be running in REAKTOR, otherwise no
MIDI clock will be sent.

9.4  Synchronization using Ableton Link

Ableton Link is a protocol that synchronizes beat, phase and tempo of Link-enabled applica-
tions on the same computer or over a shared network. This means you can conveniently keep
applications synchronized across different devices or join a group jam with others with minimal
setup. Connecting applications via Link provides you with the ability to synchronize them to a
shared timeline and change the tempo globally from each of the connected applications.
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Synchronization using Ableton Link

9.4.1 Connecting to a Network

Applications that support Ableton Link can join a Link session when connected to the same
network. To enable Link within REAKTOR, simply make sure the computer running REAKTOR
is connected to the same local network as the other applications you want to link to. This can
either be a local network or an ad-hoc (computer-to-computer) connection.

To ensure maximum security and reliability while using Link, there are several things you may
want to consider:

e For reliability, connect to the local network using a router via an Ethernet cable.

e |f you do use a Wi-Fi network, be sure to use a password to prevent excluded users from
joining your session.

e For the most secure and reliable connection, create a Link session via a direct connection
from one computer to another using a Thunderbolt or Ethernet cable.

For more general information on setting up and using Link, please refer to the Link FAQs arti-
cle located on the Ableton website:

https://help.ableton.com/hc/en-us/articles/209776125-Link-FAQs.

9.4.2 Joining and Leaving a Link Session

It is possible to join a Link session at any time by clicking the LINK button. When another
Link-enabled application is connected, a moving bar within the LINK button is displayed even
though REAKTOR's transport is not running. This bar represents the global phase of Link that
all participating applications lock into.

After clicking the Play button, playback will resume on the downbeat once the moving bar
within the LINK button is filled. The first participant to join the session sets the initial tempo,
from then on any participant in the session can change the tempo in their respective applica-
tion. If multiple participants change the tempo at the same time, the last tempo change will
take effect.

To start or join a Link session, proceed as follows:
1. Click the LINK button located in the header.
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Synchronization using Ableton Link
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= REAKTOR will either join an existing Link session or begin a new session.
2. Start REAKTOR’s playback by clicking the play button.

= REAKTOR'’s playback is now synchronized with the Link timeline.

3. To stop using Link, and leave the session, click LINK again.

While connected, the LINK button displays how many other Link-enabled applications are con-
nected via Link. The example below indicates that there are two other applications connected.

120.0 2 LINKS

Active Link session with two other instances connected.
When Link is active, it is not possible to synchronize REAKTOR to incoming MIDI Clock

or OSC Sync as a slave. Link will take priority. Sending MIDI Clock and OSC Sync from
REAKTOR as a master is still possible.
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10  Getting Deeper into REAKTOR

The present document has given you an overview over REAKTOR's interface and functionality,
and you have learned how to load and play REAKTOR instruments and effects.

To expand your knowledge about topics like Snapshots and controller integration in REAKTOR,
as well as make yourself familiar with new topics like Panelsets and the Sample Map Editor, it
is suggested that you read the REAKTOR 6 Diving Deeper document next.

If you want to use REAKTOR Racks for patching with Blocks the REAKTOR Blocks Manual pro-
vides you with all required information. It is available as part of the REAKTOR Blocks content
product. For more information about opening the manual of a content product, refer to 11.4,
REAKTOR Content Documentation.

If your goal is to build your own REAKTOR Instruments, it is still recommended that you read
the Diving Deeper document before moving on to the Building in Primary document.
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